Locate: TRIM Web Client under the following link - http://trim.monash.edu.au/hptrimwebclient/
### Version Status:

<table>
<thead>
<tr>
<th>Release Number</th>
<th>Date</th>
<th>Reason for Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>May 2012</td>
<td>First Draft – Sue Burton</td>
</tr>
<tr>
<td>0.2</td>
<td>June 2012</td>
<td>Revision – Sue Burton</td>
</tr>
<tr>
<td>0.3</td>
<td>June 2012</td>
<td>Version to be Saved as PDF</td>
</tr>
<tr>
<td>0.4</td>
<td>June 2012</td>
<td>Adjustment of See Section numbering</td>
</tr>
<tr>
<td>0.5</td>
<td>June 2012</td>
<td>Editing after corruption issue</td>
</tr>
<tr>
<td>1.0</td>
<td>June 2012</td>
<td>Further Editing</td>
</tr>
<tr>
<td>1.1</td>
<td>July 2012</td>
<td>Editing after Training</td>
</tr>
<tr>
<td>1.2</td>
<td>July 2013</td>
<td>Review post training</td>
</tr>
<tr>
<td>1.3</td>
<td>August 2013</td>
<td>Revision – Angela Cauchi</td>
</tr>
</tbody>
</table>

### Student Files Contact Details:

Email: studentfiles.clayton@monash.edu
Phone: + 61 3 990 3014

### TRIM Service Desk Contact Details:

Email: trimservice@monash.edu
Phone: + 61 3 990 55012
Table of Contents

1 About this User Guide ................................................................. 6

2 HP TRIM Overview ................................................................. 7
   2.1 Record Types ........................................................................ 7
      2.1.1 Student Documents ..................................................... 8
      2.1.2 Student Files ................................................................ 8
      2.1.3 Boxes ........................................................................ 8

3 Logging In and Setup .............................................................. 9
   3.1 Logging in ........................................................................... 9
   3.2 Bookmarking HP TRIM ......................................................... 10
      3.2.1 Access HP TRIM from the Bookmark ......................... 11

4 HP TRIM Screens and Functionality ........................................ 12
   4.1 HP TRIM log in screen ........................................................ 12
      4.1.1 Shortcuts Toolbar ......................................................... 12
      4.1.2 HP TRIM Search Results Screen ................................. 14
   4.2 Functionality – Right Mouse Click ..................................... 16
      4.2.1 Right Mouse Click on the Action tab(s) ....................... 16
      4.2.2 Right Mouse Click on a file or document .................... 17
      4.2.3 Right Mouse Click in View Pane or blank space .......... 19

5 Searching for Records ............................................................. 20
   5.1 Search Functionality ........................................................... 20
   5.2 Object Type .......................................................................... 21
   5.3 Search Types ........................................................................ 22
      5.3.1 Quick Search Function ............................................... 22
      5.3.2 Advanced Search ....................................................... 22
      5.3.3 Form Search function ............................................... 23
   5.4 Quick Search ...................................................................... 24
      5.4.1 Quick Search - Finding a Record by Record Number/Student ID ........................................... 24
      5.4.2 Quick Search - Finding Records by Record Title/Student Name ........................................... 24
   5.5 Form Search ...................................................................... 25
      5.5.1 Filter a Form Search by Record Type ......................... 27
   5.6 Sorting a Search ................................................................... 29
   5.7 Advanced Search ............................................................... 30
      5.7.1 Advanced Search - Searching for Multiple Criteria ........................................... 30
   5.8 Saving a Search ................................................................... 33
      5.8.1 Locating a Saved Search ............................................... 34
      5.8.2 Adding a Saved Search to Favourites .......................... 35
   5.9 Commonly Used Search Types ........................................... 36
1  About this User Guide

The HP TRIM 7.1 Web Client eRMS User Guide – Student Files and Documents, is for staff who have access to HP TRIM – Student Record Types within Monash University.

The major functional areas of HP TRIM explored in this manual include the following:

Depending on the user type some functions will not be accessible and the screens will differ to those in this Guide.

<table>
<thead>
<tr>
<th>Web Client Functionality</th>
<th>Inquiry User (Basic)</th>
<th>End User (Advanced)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Upload Documents</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>View Documents</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add Notes</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Modify: Title</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Modify: Container (File)</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Access Controls</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Create Files</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Create Parts</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>Print Reports</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
2 HP TRIM Overview

HP TRIM is the Records Management System used to capture, control, locate, records and information for Monash. It is the source of control and management of hardcopy and electronic records for Monash.

2.1 Record Types

Record Types are a way to group like items. A Record Type is visually distinguished by its icon (shape and colour). It also differs by its numbering pattern, its access requirements or the metadata collected against the records it represents.

Note: Student Document are contained/filed directly into a box after scanning.
2.1.1 **Student Documents**

Any Student document registered in HP TRIM must be attached (contained) to a Student file.

- Any electronic document registered in HP TRIM is a final copy.
- No changes can be made to the document after it is registered into HP TRIM.

2.1.2 **Student Files**

Student file information is uploaded from Callista to HP TRIM.

Some of the information uploaded includes:

<table>
<thead>
<tr>
<th>Student Information</th>
<th>HP TRIM Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Student ID</td>
<td>Record Number</td>
</tr>
<tr>
<td>Student Name</td>
<td>Title</td>
</tr>
<tr>
<td>Undergraduate and Graduate Coursework or HDR</td>
<td>Student Type</td>
</tr>
</tbody>
</table>

2.1.3 **Boxes**

Boxes are used by Records and Archives Services staff for managing records in off-site storage.

**Contact Student files** for advice regarding boxing Student Documents.
3  Logging In and Setup

3.1  Logging in

1. Open Mozilla (Firefox);
2. In the **internet address** field enter the address:
   trim.monash.edu.au/hptrimwebclient/
   or alternatively use
   http://ras-trim01-v01.ocio.monash.edu.au/hptrimwebclient/
   or
   http://ras-trim02-v02.ocio.monash.edu.au/hptrimwebclient/
3. In the **User Name** field enter in your Authcate User ID;
4. In the **Password** field enter in your Authcate Password;
5. **Mozilla will prompt you to remember your password** – ignore and close the dialogue box;
3.2 Bookmarking HP TRIM

1. In the Mozilla Menu click on **Bookmarks>Bookmark This Page**;
or
   Click on the Star Icon at the end of the address field;
2. In the **Page Bookmarked** dialogue change the Folder: field to Bookmarks Toolbar;
3. Make no other changes and **click on the Done button**.
3.2.1 Access HP TRIM from the Bookmark

4. In the Mozilla Menu click on View>Toolbars and tick Bookmark Toolbar;
5. The HP TRIM Bookmark will now be available under the address field.

![HP TRIM Bookmark](image)

![Gmail: Email from Google - Mozilla Firefox](image)
4 HP TRIM Screens and Functionality

4.1 HP TRIM log in screen

4.1.1 Shortcuts Toolbar

**New Tab** – available to End users only. **Record**: Allows the user to register new records into HP TRIM. (see Section 9 – Registering Documents).

**Location**: Allows the user to register new locations into HP TRIM *(not required for Student Records)*.

**Workflow** *(This function is not currently in use at Monash University)*.

**To Do Item** *(This function is not currently in use at Monash University)*.
**Favourites Tab**

**Records:** Allows the user to view Records saved to favourites.

**Locations:** Allows the user to view Locations saved to favourites.

**Classifications:** Allows the user to view Classifications saved to favourites.

**Saved Searches:** Allows the user to view Saved Searches saved to favourites.

**Recent Tab** - available to End users only.

**My Containers:** Allows the user to view the last 25 Files that they uploaded documents to.

**Recent Documents:** Allows the user to view the last 25 Documents that they uploaded.

**Trays Tab**

**Records In Tray:** Shows any record that is assigned to your name.

**Records Due Tray:** *(This function is not in use at Monash University).*

**Records Work Tray:** Allows the user to view Records saved to the work tray.

**Activities Due:** *(This function is not in use at Monash University).*

**Records In or Due Tray:** *(This function is not in use at Monash University).*

**My To Do Items:** *(This function is not currently in use at Monash University).*

**Documents Checked Out:** *(This function is not in use at Monash University).*
4.1.2 HP TRIM Search Results Screen

**Action Tabs:** When each new action is generated a new ‘action tab’ opens on the top of the screen in HP TRIM.

**List Pane and Column Headings (Top Half of the Screen):** Listed at the top of the screen are the results based on the Search Type and value used (see Section 13 - Customising HP TRIM Web Client Screens - Appendix 3 for information regarding list pane defaults).

Click on the Column headings to sort the order of the records listed.

Sort will not work with a large search result – a warning will be generated if this occurs.

**Page Count:** provides information about how many pages of results have been returned.

**Screen Refresh:** click on the screen refresh icon to update the results on the screen.

**Search Result Count:** provides information about how many records have been returned.
View Pane (Bottom Half of the screen): This half of the screen shows the properties of the record highlighted in the List Pane (see Section 13 – Customising HP TRIM Web Client Screens - Appendix 3 for information regarding view pane defaults).

View Pane (bottom half of screen)

View Panes Tabs: Under the view pane are the Properties and Notes tabs.

Properties Tab: provides a view of the metadata about the record.

Notes Tab: provides a view of any notes attached to the document or file in a separate window.

Log on Information: provides information about who is logged in and what database is in use.
4.2 Functionality – Right Mouse Click

4.2.1 Right Mouse Click on the Action tab(s)

Right mouse click on the action tab at the top of the screen and the options available are:

- **Link**
  - Will open a new session of HP TRIM.

- **Feed**
  - Will feed to a list screen that enables records to be printed from the list pane (See Section 12 - Printing Reports).

- **Close Tab**
  - Will close the tab selected.

- **Close Other Tabs**
  - This option is only available when more than one tab is open, and will close all tabs except the highlighted tab.
4.2.2 **Right Mouse Click on a file or document.**

Right Mouse Click on a file or document in the list pane and the options available are dependent on the user access you have been given.
The functions of each menu is listed in the table below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Right mouse click on a File</th>
<th>Document</th>
<th>Description</th>
<th>Available for Basic Users</th>
<th>Available for Advanced Users</th>
<th>Refer to Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>✓</td>
<td>✓</td>
<td>Enables the creation of a New Record.</td>
<td>×</td>
<td>✓</td>
<td>Section 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Registering</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Document s</td>
</tr>
<tr>
<td>Search</td>
<td>✓</td>
<td>✓</td>
<td>Enables Searching.</td>
<td>✓</td>
<td>✓</td>
<td>Section 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Searching for</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Records</td>
</tr>
<tr>
<td>Navigation</td>
<td>✓</td>
<td>✓</td>
<td>Enables Navigation to other linked records.</td>
<td>✓</td>
<td>✓</td>
<td>Section 6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Navigating and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Viewing</td>
</tr>
<tr>
<td>Contained Records</td>
<td>✓</td>
<td>✓</td>
<td>Enables navigation to documents contained or attached to the file</td>
<td>✓</td>
<td>✓</td>
<td>Section 6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Only available if an electronic document is attached).</td>
<td></td>
<td></td>
<td>Navigating and</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Viewing</td>
</tr>
<tr>
<td>View</td>
<td>×</td>
<td>✓</td>
<td>Opens and electronic document.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Electronic</td>
<td>×</td>
<td>✓</td>
<td>Function not in use at Monash</td>
<td>×</td>
<td>✓</td>
<td>Section 11.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Adding a Note</td>
</tr>
<tr>
<td>Details</td>
<td>✓</td>
<td>✓</td>
<td>Enables access to Notes and Active Audit Events.</td>
<td>✓</td>
<td>✓</td>
<td>Section 11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Modifying Records</td>
</tr>
<tr>
<td>Locations</td>
<td>✓</td>
<td>✓</td>
<td>Enables access to view contacts/authors associated with the record.</td>
<td>✓</td>
<td>✓</td>
<td>Section 7</td>
</tr>
<tr>
<td>Workflow</td>
<td>✓</td>
<td>✓</td>
<td>Is not a function is not currently in use at Monash.</td>
<td>×</td>
<td>×</td>
<td>Locations</td>
</tr>
<tr>
<td>Send To</td>
<td>✓</td>
<td>✓</td>
<td>Enables adding records to Favourites and other quick reference tools.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Remove From</td>
<td>✓</td>
<td>✓</td>
<td>Enables removal of records from Favourites and other quick reference tools.</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>✓</td>
<td>✓</td>
<td>Enables access to modify metadata associated with the record such as: title,</td>
<td>✓</td>
<td>✓</td>
<td>Section 11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>container, assignee.</td>
<td></td>
<td></td>
<td>Modifying Records</td>
</tr>
</tbody>
</table>
### 4.2.3 Right Mouse Click in View Pane or blank space

This option relates to the internet functions, and not HP TRIM functionality. Use of these options is not recommended.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td></td>
</tr>
<tr>
<td>Forward</td>
<td></td>
</tr>
<tr>
<td>Reload</td>
<td></td>
</tr>
<tr>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>Bookmark This Page</td>
<td></td>
</tr>
<tr>
<td>Save Page As...</td>
<td></td>
</tr>
<tr>
<td>Send Link...</td>
<td></td>
</tr>
<tr>
<td>View Background Image</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td></td>
</tr>
<tr>
<td>View Page Source</td>
<td></td>
</tr>
<tr>
<td>View Page Info</td>
<td></td>
</tr>
<tr>
<td>Inspect Element (Q)</td>
<td></td>
</tr>
</tbody>
</table>
5 Searching for Records

5.1 Search Functionality

To run a search you must select the appropriate Object Type and Search Type and enter the Search Criteria to generate a search result.

At the end of the Search Criteria field is a Drop Down Arrow and a Magnifying Glass Icon.

Depending on the Object Type, Search Type selected there are different methods by which the Search Criteria must be entered to generate the search.
5.2 Object Type

Under the Object Type drop down arrow there are a variety of values to be selected to generate different types of searches.

For Student Records searches the Object Type selected should be **Record**.
5.3 Search Types

5.3.1 Quick Search Function

The Quick Search function: allows users to run a simple search using simple Search Criteria (see Section 5.4 for information how to search using Quick Search).

5.3.2 Advanced Search

The Advanced Search function: allows users to run more complex searches (see Section 5.7 for information how to search using Advanced Searching).
5.3.3 **Form Search function**

**The Form Search function:** provides a structured form for a search to be generated (see Section 5.5 for information how to search using a Form Search).

- Users can apply the Advanced Search or the Form Search functions to search for multiple criteria.

  Multiple Search Combinations could include:
  
  - Title Word and By Date Registered
  - Title Word and Student Documents and/or Files Only.
5.4 Quick Search

5.4.1 Quick Search - Finding a Record by Record Number/Student ID

1. Select Record in the Object Type Field;
2. Select Quick Search in the Search Type Field;
3. In the Enter Search Criteria field enter in the Student ID Number;
4. Click on Search or press enter.

5.4.2 Quick Search - Finding Records by Record Title/Student Name

1. Select Record in the Object Type Field;
2. Select Quick Search in the Search Type Field;
3. In the Search Criteria field enter in the Student Name:
The preferred search method:
   • is to search for the students last name only;
   • however, if it is necessary to search for a student’s full name each
     name must be separated by the word and;
4. Click on Search or press enter.

For Example: Clooney and George

Enter the word and between names
5.5 Form Search

The form search allows the user to run a structured search.

1. In the **Object Type** field leave as *Record*;
2. In the **Search Type** field click on the drop down arrow and select *Form Search*;
3. At the end of the **Search Criteria** field click on the magnifying glass icon;
4. In the **Title** field enter the Students Last Name and Given Name;
5. **Record form Search dialogue box** fill in the Search Criteria depending on the search result required;
6. **Click on Search** or press enter.

---

**Note**: When searching for a student’s name it must be entered in the same order as it would on the file or document such as Last name Given Name.

**For Example**: Clooney George
The function of each field in the Form search is described in the table below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Allows a user to search for any information entered into the Title Field of student records. Such as: Student Last Name, and Given Names</td>
</tr>
<tr>
<td>Notes</td>
<td>Allows a user to search for any information entered into the Notes Field of records.</td>
</tr>
<tr>
<td>Content</td>
<td>Allows a user to search for any word or phrase within the content of a document - that has been scanned using OCR or born digital documents such as Microsoft or email.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Allows a user to search for any hardcopy records assigned to a person.</td>
</tr>
<tr>
<td>Container</td>
<td>Allows a user to search for the containers they have recently contained documents to (not a basic user function).</td>
</tr>
<tr>
<td>External ID</td>
<td>This function is not in use at Monash University.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Allows a user to search for the date a record was authored or signed.</td>
</tr>
<tr>
<td>Date Registered</td>
<td>Allows a user to search for the date a record was registered into HP TRIM.</td>
</tr>
<tr>
<td>Owner Location</td>
<td>Do not search by owner location - as the owner of Student Files is Monash University.</td>
</tr>
<tr>
<td>Record Type</td>
<td>Allows a user to filter the to only search for selected record types. Such as: Student Document and Student File.</td>
</tr>
<tr>
<td>Expanded Number</td>
<td>Allows a user to search for any records by a: Student ID, or Document number (in the format SD2012/0001234)</td>
</tr>
</tbody>
</table>
5.5.1 Filter a Form Search by Record Type

1. To filter a form search by Record Type: In the **Title** field enter a search criteria;

2. **Click on the drop down arrow at the end of the Record Type Field**;
3. **Tick the Record Types** to search;
4. **Click on OK**;

5. **Click on Search**.
5.6 Sorting a Search

Sorting can be activated by clicking on the column headings in the list pane when a search is generated.

Sorting by column heading will not work with a large search result – a warning will be generated if this occurs.

Sorting can also be activated by selecting sort when running an advanced or form search.

To sort a form search:

1. Click on the Sort tab;
2. Select a sort criteria;
3. Click on Search.
5.7 Advanced Search

5.7.1 Advanced Search - Searching for Multiple Criteria

1. In the Object Type field leave as Record;
2. In the Search Type field click on the drop down arrow and select Advanced Search;
3. At the end of the Search Criteria field click on the magnifying glass icon;

4. In the Search for Records dialogue box ensure that the word Record is highlighted (this will change depending on the Object Type field option selected);
5. Click on the Add search clause function;
6. In the **Record search builder dialogue box** highlight the first search option to search by:

   a. Selecting Any Word search  
   b. Click on OK
7. Click on the **Add search clause function again**;

8. Enter the **Search Criteria** in the fields available at the bottom of the dialogue box (these will change depending on the Object Type used);

9. **Click on OK**;

10. **Click on Search**.
5.8 Saving a Search

Whenever a search has been generated in HP TRIM it can be saved and re-run at any time.

1. **Run the required search**;
2. **Right mouse click** in the list pane and **select Search>Save Search As**;
3. In the **Name field** enter a name for your search;
4. **Click on Save**;
5.8.1  **Locating a Saved Search**

To locate and open a saved search

1. **Change the Object Type to Saved Search**;
2. In the **Search Type** change to **Form Search**;
3. Click on the **magnifying glass**;
4. In the **Saved Search Form Search dialogue box** Tick the **All**: tick box;
5. **Click on Search**;
6. **Right mouse click** in the list pane and **select Open**.
5.8.2 Adding a Saved Search to Favourites

To add the saved search to Favourites:

1. Change the Object Type to Saved Search;
2. In the Search Type change to Form Search;
3. Click on the magnifying glass;
4. In the Saved Search Form Search dialogue box Tick the All: tick box;
5. Click on Search;
6. Right mouse click and select Send To>Favourites.
5.9 Commonly Used Search Types

In an advanced search follow the next 5 steps to view the search types available.

1. In the **Object Type field leave as Record**;
2. In the **Search Type field click on the drop down arrow and select Advanced Search**;
3. At the end of the **Search Criteria field click on the magnifying glass icon**;
4. In the **Search for Records** dialogue box ensure that the word Record is **highlighted** (this will change depending on the Object Type field option selected);
5. Click on the **Add search clause function**;
Click on the + sign to show the various search types available

The most commonly used Search Types include:

**Under Recent**
- the most recently used Object Types will be accessible.

**Under the Text Search category**
- Title Word;
- Notes Word;
- Any Word (recommended).

**Under the Reference and Control Numbers category**
- Record Number.

**Under the Trays and Labels category**
- Favourites Tray.

**Under the Dates and Times category**
- Date Created;
- Date Registered.

**Under the Contacts, People and Places category**
- Assignee;
- Creator.

**Under Type**
- Record Type.
6  Navigating and Viewing

The Navigation function in HP TRIM provides access to records that are connected to each other through Container (file) Contained Records (filed documents) and Parts.

The navigation options will only be available if the function has been used.

6.1  Navigate to Documents Attached to a File

1. Search and highlight the file;
2. In the list pane right mouse click and select Navigation>Contained Records;

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Record Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>STUDENT FILE</td>
<td>21065276</td>
</tr>
</tbody>
</table>

   - New
   - Search
   - Navigation

   - Contained Records
   - Details
   - Locations
   - Workflow
   - Send To
   - Remove From

   - Properties
6.2 Navigate to a File from a Document

1. Search and highlight the file;
2. In the list pane right mouse click and select Navigation>Container Record;

6.3 Viewing a Document

1. Search and highlight the document;
2. In the list pane right mouse click and select View.
6.4 Viewing All Parts

1. **Search and highlight the file**;
2. In the list pane **right mouse click** and select Details>Relate;

All parts and other related records will be listed.
7 Locations

Locations (or contacts) are used as an identifier to indicate:

- The assignee of a record;
- The ownership of a record;
- The home or storage location of a record;
- Who registered a record;

7.1 Locations/Contacts

Locations or contacts in TRIM are identified by a green or red icon.

**Green Icons** indicate internal staff, groups or organisations.

Internal locations are structured into a hierarchy which mirrors the Monash University structure as closely as possible.

Internal locations are managed by the TRIM Service Desk staff, on notification of changes from staff within Monash University.

**Red icons** indicate external locations: for example:

- individuals (such as students); or
- organisations (such as businesses or agencies).

Student locations are created when uploaded from Callista.
## 7.2 Location Types

There are location types in HP TRIM that enable the capture metadata linking contact location information to records. The category types are:

<table>
<thead>
<tr>
<th>Location Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignee Location</td>
<td>Assignee Location applies to hardcopy records, and indicates the current location of that record. The Assignee Location for an electronic file will be indicated as Records Storage: Electronic.</td>
</tr>
<tr>
<td>Home Location</td>
<td>The Home Location for a hardcopy file indicates the storage location for that file. The Home Location for an electronic file will be indicated as Records Storage: Electronic.</td>
</tr>
</tbody>
</table>
7.3 Changing the Assignee of a Record

The assignee is an indicator of the current location of a hardcopy file or if the file is electronic.

To change the assignee:

1. **Search and highlight the file**;
2. **Right mouse click** and select **Locations>Assignee**;
3. **Select the Set to Location radio button**;
4. In the blank field under the **Set to Location radio button enter in the last name of the new Assignee and click on the icon** at the end of the field;
5. Search and **select the matching** (green internal) name from the **contacts list**;

6. **Click on OK**;

7. **Click on OK**.
8 Access Controls

Only staff with Student Administrative responsibilities can view student records within HP TRIM.

Access restrictions in HP TRIM are placed on the Student file Record Type, and documents contained within the file inherit the same restrictions. Access is based on:

i. The sensitivity or confidentiality of the content of the record and can be set on individual documents as required.

ii. It is also based on your log on profile for example: Inquiry Users can view records, update some details but not others. Administrators have full access rights.

8.1.1 Access Control

The access controls in HP TRIM are grouped into seven functions as listed in the diagram below;
The table below shows the default access controls applied on Student Files and Documents:

<table>
<thead>
<tr>
<th>Access Control Category</th>
<th>Access Control – File</th>
<th>Access Control – Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Document</td>
<td>Student Records – View</td>
<td>Inherits from File</td>
</tr>
<tr>
<td>View Metadata</td>
<td>Student Records – View</td>
<td>Inherits from File</td>
</tr>
<tr>
<td>Update Document</td>
<td>Student Records – Create</td>
<td>Inherits from File</td>
</tr>
<tr>
<td>Update Record Metadata</td>
<td>Student Records – View</td>
<td>Inherits from File</td>
</tr>
<tr>
<td>Modify Record Access</td>
<td>Records and Archives Services</td>
<td>Student Records - Create</td>
</tr>
<tr>
<td>Destroy Record</td>
<td>Records Disposal</td>
<td>Records Disposal</td>
</tr>
<tr>
<td>Contribute Contents</td>
<td>Student Records – Create</td>
<td>Inherits from File</td>
</tr>
</tbody>
</table>

### 8.2 Changing and Applying Access Controls

The Web client at this stage does not enable amendment of Access Controls. When a document needs access control applied, email the TRIM Service Desk.
9 Registering Documents

9.1.1 Record Titling Conventions

Do:

- Do **Register Student Documents with meaningful titles** – Using the Student Titling Conventions.
- Do **Use consistent language**.
- Do **Use a hyphen with a space at either side to break up a title instead of punctuation**.
- Do **Avoid Jargon**.
- Do **Enter a Full Name such as**: CLOONEY George
- Do **Use the Notes field** if the Title field is not long enough.
- Do update titles on documents from email or scanned documents when saving to HP TRIM.

Do Not:

- Do Not **Use terms** such as: **general and miscellaneous** in titles.
- Do Not **Use symbols**; such as: ! * or @ in the title.
- Do Not use comma's between names
- Do Not **Use Punctuation**; such as: ; . : ; ‘”[]{}
- Do Not **Use abbreviations**; such as: BioEco, Mtg - This creates inconsistency and hampers searching.
- Do Not **Use acronyms - unless listed in the Student Titling Conventions**
9.2 Registering a Student Document

To register a document into TRIM, the user must have End User access or higher:

1. In the **Shortcuts bar to the left of the screen click on the New tab and select Record Icon**;

2. Select the **Student Document Type**;

3. **Click on OK**;
In the default screen (General Tab)

4. In the field **Title (Free Text Part): enter the document details** as described in agreed Student Titling Conventions;

5. In the field **Container: enter the Student ID** if known or **click on the icon at the end of the field** and **search for the file**;

6. In the field **Date Created: enter the correct document date**;

7. In the field **Access Control**: leave as the default – this cannot be amended in the web client;

8. In the field **Electronic Document: click on the browse icon at the field**;

---

The Date Created will automatically populate for electronic documents so confirm that the date is correct;
9. In the **Upload dialogue box** click on the **Browse** button;

10. **Locate the document, and highlight**;

11. **Click on Open**;
The document will now be listed in the Upload dialogue box;

12. **Click on Save**; an upload bar will appear;

13. **In the Status dialogue box click on OK**;
14. **Click on Save**.

The Uploaded document appears here.
10 Saving an Email to HP TRIM

To save and email only or an email with an attachment:

10.1.1 To save and email only or an email with an attachment

1. Open Google email using Mozilla Firefox browser;
2. Open the email to be saved to HP TRIM;
3. Click on the Drop down to the right of the email time stamp;
4. Select Show Original; A screen of script will appear;

5. In the Menu Select File>Save Page As;
6. In the **Save in:** field determine where to save to (A folder on the Desktop is recommended);

7. In the **File Name:** field ensure the extension is changed to `.eml`;

8. In the **Save as type:** field **Click** on the drop down and **Select All Files**;

9. **Click** on the **Save button**;

Go to the location the email was saved to:

10. **Save the email to TRIM** (see Section 9.2 Registering a Student Document).
10.1.2 To save an email attachment only

1. Open email using browser;
2. Open the email with the attachment to be saved to HP TRIM;
3. Click on the Download option next to the attachment;
4. In the Opening....dialogue box, ensure that Open With is selected and click on OK;
5. File and save the attachment using the native program’s (such as Windows or Adobe) functionality;
6. Save the attachment to TRIM (see Section 9.2 Registering a Student Document).
11 Modifying Records

11.1 Changing a Title

The title of a document can be changed if necessary for example, to correct a typing error.

To change a record title:

1. Search and highlight the record;
2. Right mouse click and select Properties;
3. Edit the Title as required;
4. Click on Save.
11.2 Changing the location of a Document to Another File (Container)

To change the file location of a document:

1. **Search and highlight the record**;
2. **Right mouse click and select Properties**;
3. In the **Container field replace the Student ID number**;
4. **Click on Save**.

Enter the replacement Student ID

![Image showing the properties dialog box with fields for record details and access control options.](image-url)
11.3 Adding a Note

- End Users cannot modify or delete notes when saved into HP TRIM.
- Contact the TRIM Service Desk if a note needs to be modified.

To add a note:

1. Search and highlight the record;
2. Right mouse click and select Properties;
3. In the properties screen click on the Notes Tab at the bottom of the screen;
4. **Click on the Insert User Stamp Button**;
5. In the **Notes**: field under the new user stamp enter the additional information required;
6. **Click on Save**.
12 Printing Reports

You can print a report from the search results displayed.

1. **Right Mouse click on the Search Results tab and Select Feed**;

![Screen shot of HP TRIM Record Feed - Mozilla Firefox](image)

2. In the **HP TRIM Record Feed – Mozilla Firefox screen select File>Print**.
13 Customising HP TRIM WebClient Screens

13.1 Formatting Columns

13.1.1 Adding New Columns

1. With a search result displayed **click on the drop down arrow on any Column Heading**;

2. Select **Format Columns**;

3. In the Available Properties or Fields column - **double click on the column heading to be added**;

![Record Drop Down Arrow]

![Select format columns]

![Double Click on the column heading]
4. Ensure that the column heading is now located in the Selected Properties or Fields column;
5. Use the **Move Up** or **Move Down** buttons to alter the order of the columns;
6. **Click on OK.**
13.1.2 Removing Displayed Columns

1. With a search result displayed **click on the drop down on any Column Heading**;

2. Select **columns**;

3. **Untick the column** that is not needed.
13.2 Formatting View Panes

13.2.1 Adding and Removing fields to the View Pane

1. With a search result displayed click on the drop down on any Column Heading;

2. Select Customize View Pane;

3. In the Available Properties or Fields column - double click on the view pane field heading to be added;

   It is recommended that All Parts be added to the View Pane.
4. Ensure that the view pane heading is now located in the Selected Properties or Fields column;

5. Use the Move Up or Move Down buttons to alter the order of the view pane headings;

6. Click on OK.

13.2.2 To remove a View Pane heading

2. With a search result displayed click on the drop down on any Column Heading;

3. Select Customize View Pane;

4. In the Available Properties or Fields column - double click on the view pane heading to be removed;

5. Click on OK.
## Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
<th>Used as/for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>The ability to control who can view, access and modify a record in HP TRIM.</td>
<td></td>
</tr>
<tr>
<td>Assignee</td>
<td>The person who has been allocated a physical file or document.</td>
<td>Current Location</td>
</tr>
<tr>
<td>Contact</td>
<td>An External location used for recording who received or sent correspondence to Monash.</td>
<td>Author; Creator</td>
</tr>
<tr>
<td>Container</td>
<td>A file that contains the documents.</td>
<td>File Box</td>
</tr>
<tr>
<td>Current</td>
<td>The person who has been allocated a physical file or document.</td>
<td>Current Location</td>
</tr>
<tr>
<td>File Extension</td>
<td>The information recorded when a document is saved to indicate in was format and system to open it for example: .doc = Microsoft Office Word.</td>
<td>Document Registration; Searching</td>
</tr>
<tr>
<td>Home</td>
<td>The storage location of the record.</td>
<td>Home Location</td>
</tr>
<tr>
<td>Owner</td>
<td>The location responsible for the record.</td>
<td>Owner Location</td>
</tr>
<tr>
<td>Record Type</td>
<td>Category set up with defined date collection requirements.</td>
<td>All functions within HP TRIM</td>
</tr>
</tbody>
</table>
# Appendix 1 - Record Types

<table>
<thead>
<tr>
<th>Icon</th>
<th>Record Type</th>
<th>Numbering</th>
<th>Classification</th>
<th>Free Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td><strong>Central Document</strong></td>
<td>CD08/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used for documents across all central administration services.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Central File</strong></td>
<td>CF08/1</td>
<td>✔️</td>
<td>✔️</td>
<td>Used for files across all central administration services.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Legal Document</strong></td>
<td>LD08/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used to register legal documents, including originals and amendments.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Legal Folder</strong></td>
<td>LF08/1</td>
<td>Not applicable</td>
<td>✔️</td>
<td>Used to register folders to contain legal documents.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>HR Document</strong></td>
<td>HRD08/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used to register HR documents by Human Resources.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Staff File</strong></td>
<td>STAFF08/1</td>
<td>Not applicable</td>
<td>✔️</td>
<td>Used to register staff files by Human Resources.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>HR Subject File</strong></td>
<td>HR08/1</td>
<td>✔️</td>
<td>✔️</td>
<td>Used to register mostly advertisement files and other HR subject files by Human Resources.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>HR Box</strong></td>
<td>0261-000001</td>
<td>Not applicable</td>
<td>✔️</td>
<td>Used by Human Resources to register boxes containing terminated staff files to be stored off site.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Student Document</strong></td>
<td>SD08/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used by staff responsible for Student Administration to register student documents.</td>
</tr>
<tr>
<td>![Folder]</td>
<td><strong>Student File</strong></td>
<td>20734395  (student ID)</td>
<td>Not applicable</td>
<td>✔️</td>
<td>Used to register Student Files by Records and Archives Services.</td>
</tr>
<tr>
<td>Icon</td>
<td>Record Type</td>
<td>Numbering</td>
<td>Classification</td>
<td>Free Text</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Facilities and Services File</td>
<td>FSF09/1</td>
<td>✓</td>
<td>✓</td>
<td>Used to register files by Facilities and Services Division.</td>
<td></td>
</tr>
<tr>
<td>Facilities and Services Document</td>
<td>FSD09/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used to register documents by Facilities and Services Division.</td>
<td></td>
</tr>
<tr>
<td>Faculty of Business and Economics Document</td>
<td>BED11/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used by the Faculty of Business and Economics to register faculty documents.</td>
<td></td>
</tr>
<tr>
<td>Faculty of Business and Economics File</td>
<td>BEF11/1</td>
<td>✓</td>
<td>✓</td>
<td>Used to register files for the Faculty of Business and Economics.</td>
<td></td>
</tr>
<tr>
<td>Faculty of Education Document</td>
<td>EDD08/1</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used by the Faculty of Education to register faculty documents.</td>
<td></td>
</tr>
<tr>
<td>Faculty of Education File</td>
<td>EDF08/1</td>
<td>✓</td>
<td>✓</td>
<td>Used by the Faculty of Education to register faculty files.</td>
<td></td>
</tr>
<tr>
<td>Residential Services Document</td>
<td>RD12/38</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used by Residential Services to register resident student documents.</td>
<td></td>
</tr>
<tr>
<td>Residential Services File</td>
<td>RF/22601309</td>
<td>Not applicable</td>
<td>✓</td>
<td>Used by Residential Services to register resident student files.</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>Record Type</td>
<td>Numbering</td>
<td>Classification</td>
<td>Free Text</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="" alt="Icon" /></td>
<td>Student Card – Archives</td>
<td>SD0054511</td>
<td>Not applicable</td>
<td>✓</td>
<td>Digitised copies of summary student record cards for Clayton students enrolled between 1961–1986 and 1990; Gippsland students enrolled 1968-1978; Pharmacy College students 1960-1980; and Frankston Teachers College/SCV 1959-1974. Academic statements of Open Learning students whose complete record is not in Callista are also included in this Item Type.</td>
</tr>
<tr>
<td><img src="" alt="Icon" /></td>
<td>Staff Record – Archives</td>
<td>E00236491 (staff ID)</td>
<td>Not applicable</td>
<td>✓</td>
<td>Used by Archives to register electronic copies of staff files which pre-date HR-SAP.</td>
</tr>
<tr>
<td><img src="" alt="Icon" /></td>
<td>Archival Document</td>
<td>2001/12-E17</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Used by Archives to register electronic records of previously unregistered in the University’s Records Management System and assessed as having ongoing value.</td>
</tr>
<tr>
<td><img src="" alt="Icon" /></td>
<td>Archival Folder</td>
<td>MON1206/007</td>
<td>Not applicable</td>
<td>✓</td>
<td>Used by Archives to register groups of Archival Documents, transferred at one time, from a single source.</td>
</tr>
<tr>
<td><img src="" alt="Icon" /></td>
<td>Archival Series</td>
<td>MON0254 Box1/07 (UCollect numbers)</td>
<td>Not applicable</td>
<td>✓</td>
<td>Used by Archives to reflect groups of associated records held within the Archives Repository (may include Archival Documents).</td>
</tr>
<tr>
<td>Icon</td>
<td>Record Type</td>
<td>Numbering</td>
<td>Classification</td>
<td>Free Text</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------</td>
<td>----------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Legacy File</td>
<td>UCollect numbers</td>
<td>Not applicable</td>
<td>✓</td>
<td>Direct migration of UCollect Item Types RMO-FILE, RMOR-FILE, RMO-TFILE, RMOR-TFILE. *RMOT-FILE will receive prefix on number of RMOT.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Legacy RMOR-LEGAL</td>
<td>UCollect numbers</td>
<td>Not applicable</td>
<td>✓</td>
<td>Direct migration of UCollect Item Type RMOR-LEGAL.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Legacy MUA</td>
<td>UCollect numbers</td>
<td>Not applicable</td>
<td>✓</td>
<td>Direct migration of UCollect Item Types MUA-CHIS, MUA-GIPPS, MUA-PRETM.</td>
</tr>
</tbody>
</table>
### Appendix 2 - Additional Fields

<table>
<thead>
<tr>
<th>Search Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accession History</td>
<td>Used by Monash University Archives to indicate access history.</td>
</tr>
<tr>
<td>Accession Number MUA</td>
<td>Used by Monash University Archives to record accession number.</td>
</tr>
<tr>
<td>Agreement Date</td>
<td>Agreement date of legal documents.</td>
</tr>
<tr>
<td>Creating Agency</td>
<td>Used by Monash University Archives to record the agency that created the records.</td>
</tr>
<tr>
<td>End Date</td>
<td>End date of legal documents.</td>
</tr>
<tr>
<td>Location – Repository</td>
<td>Used by Monash University Archives to record physical location of items.</td>
</tr>
<tr>
<td>Movement History Legacy</td>
<td>Captures the movement history for records migrated from UCollect.</td>
</tr>
<tr>
<td>No End Date</td>
<td>Field used to provide information on a legal document where no end date has been provided.</td>
</tr>
<tr>
<td>Provenance</td>
<td>Automatically captures the organisational details of the user registering records into HP TRIM into a read-only field.</td>
</tr>
<tr>
<td>Reactivate Date</td>
<td>Used by Monash University Archives to show when a staff file has been reactivated.</td>
</tr>
<tr>
<td>Signature Date</td>
<td>Signature date on legal documents.</td>
</tr>
<tr>
<td>Staff ID</td>
<td>Used by Human Resources to record Staff ID.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start Date of legal documents.</td>
</tr>
<tr>
<td>Student ID</td>
<td>Used by Records and Archives Services to record Student ID.</td>
</tr>
<tr>
<td>Student Type</td>
<td>Used by Records and Archives Services to record Student Degree Type.</td>
</tr>
<tr>
<td>Termination Date</td>
<td>Used by Human Resource to indicate termination date of visiting staff.</td>
</tr>
<tr>
<td>Transferring Agency</td>
<td>Used by Monash University Archives to record the agency that transferred the records to Archives.</td>
</tr>
<tr>
<td>UCollect Item ID</td>
<td>Records the Item Type on records migrated from a previous Records Management System.</td>
</tr>
<tr>
<td>Search Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UCollect Status</td>
<td>Records the Status information on records migrated from a previous Records Management System.</td>
</tr>
<tr>
<td>UCollect Status Date</td>
<td>Records the Status Date on records migrated from a previous Records Management System.</td>
</tr>
</tbody>
</table>
Appendix 3 – Screen Settings

The column headings in the List Pane for a Student File and Student Document will always appear as:

<table>
<thead>
<tr>
<th>List Pane Column Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Record Type;</td>
</tr>
<tr>
<td>• Record Number;</td>
</tr>
<tr>
<td>• Title;</td>
</tr>
<tr>
<td>• Date Created.</td>
</tr>
</tbody>
</table>

Depending on the Record Type selected different information will be displayed in the View Pane.

The View Pane field headings for a Student File will default to:
• Record Number;
• Title;
• Student Type;
• Date Registered;
• Date Closed;
• Assignee;
• Home Location;
• All Parts;
• Notes;
• Access Control.

The View Pane field headings for a Student Document will default to:
• Record Number;
• Title;
• Container;
• Date Created;
• Date Registered;
• Creator;
• Notes;
• Access Control.
Locate: TRIM Web Client under the following link - http://trim.monash.edu.au/hptrimwebclient/
Appendix 4 – Who to Contact for Help?

• Student Files Contact Details:

For Issues with Student Information within TRIM

Email: studentfiles.clayton@monash.edu

Phone: + 61 3 990 3014

• TRIM Service Desk Contact Details:

For Issues with the HP TRIM system

Email: trimservice@monash.edu

Phone: + 61 3 990 55012

• Records and Archives Web site:

http://adm.monash.edu/records.archives/
Locate: TRIM Web Client under the following link - http://trim.monash.edu.au/hptrimwebclient/